Referencing – APA 6th Edition

Adapted for use at James Cook University from:

Go to the libguide for more examples: http://libguides.jcu.edu.au/referencing

Top Tips ...................................................................................................... 3

Place of publication (APA, 2010, p. 187) ................................................................. 3
Author and publisher are the same (APA, 2010, p.203) ............................................ 3
Cite a source that you found in another source ....................................................... 3
No author and /or no date ................................................................................... 3
   Print version: .................................................................................................................. 3
   Electronic version: .......................................................................................................... 3
Long URLs ......................................................................................................... 3
Two entries by same author, same date: .................................................................. 3

Book (APA, 2010, p. 202) ..................................................................................... 4
   Book with single author: .......................................................................................... 4
   Book with multiple authors: .................................................................................... 4
      Two to six authors: .................................................................................................... 4
      More than six authors: .......................................................................................... 4
   Book with editor(s): ............................................................................................... 4
   Book, author not known: ....................................................................................... 4
   Book with author and editor: ................................................................................. 4
   Book other than first edition: ................................................................................. 4
   Book with more than one volume: .......................................................................... 4
Electronic-only book (APA, 2010, p. 203) ............................................................... 4
   Book with corporate author: ................................................................................... 5
   Chapter or article in a book (APA, 2010, p. 204) ...................................................... 5
Dictionary, encyclopedia ....................................................................................... 5
Dictionary entry, encyclopedia article ...................................................................... 5
Online dictionary, encyclopedia .............................................................................. 5

Notes for Journal Articles .................................................................................... 5
DOI – Digital Object Identifier .................................................................................... 5
Pagination by issue vs. pagination by volume .......................................................... 6
   Pagination by issue: .................................................................................................. 6
   Pagination by volume: ............................................................................................ 6

Journal Articles (APA, 2010, pp. 198-199) ............................................................ 6
   Journal article: with doi, pagination by issue ......................................................... 6
   Journal article: with doi, pagination by volume ..................................................... 6
   Journal article: without doi, pagination by issue .................................................. 6
   Journal article: without doi, pagination by volume ............................................... 6
Websites & online resources ................................................................. 7

Web page ........................................................................................................ 7
Web page: no author ........................................................................................ 7
Website: no author, no year, no page number (APA, 2010, pp. 170-171) ............ 7
Facebook ......................................................................................................... 7
Newspaper article (including discontinuous pages) (APA, 2010, p.200) ............. 7
Lecture notes ................................................................................................. 7
Further Examples ............................................................................................ 8
Conference Papers (APA, 2010, p. 207) .......................................................... 8
  Unpublished conference paper, unpublished paper ........................................... 8
  Published conference paper in conference proceedings ................................... 8
Thesis (APA, 2010, p. 207) ........................................................................... 8
Government publication: Australian Bureau of Statistics (ABS) ....................... 8
Government publication: government department ............................................ 8
Government report, corporate author (APA, 2010, 205)..................................... 8
Personal communication - letters, email, interviews, telephone conversation .... 9
Audiovisual ..................................................................................................... 9

In-text citations .............................................................................................. 9

Short quote - less than 40 words (APA, 2010, p.171) ........................................ 9
Long quote – more than 40 words (block quote) .............................................. 9
Two authors .................................................................................................. 10
Three, four or five authors ............................................................................. 10
Six or more authors ....................................................................................... 10
Long author .................................................................................................. 10
No author (APA, 2010, p.176) ................................................................. 10
Top Tips

**Place of publication** (APA, 2010, p. 187)

Some references require you to enter the place/location of the publisher. For multiple locations give the first one or if obvious, the location of the head office.

**USA publishers:** Give the city in full and the two letter abbreviation for the state:

- New York, NY
- Springfield, MA

**Publishers outside the USA:** Give the city in full and the country in full:

- London, England:
- Auckland, New Zealand

**Author and publisher are the same** (APA, 2010, p.203)

When author and publisher are identical, use the word “Author” as the publisher.


**Cite a source that you found in another source**

If Allport's work is cited in Nicholson and you did not read Allport’s work, list the Nicholson reference in the reference list. In the text, use the following citation:

- Allport's diary (as cited in Nicholson, 2003).

**No author and/or no date**

If you cannot find the author place the title in the author position. Use n.d. (no date) where no publication date is available.

**Print version:**


For in-text citation, replace author with part, or if short, all of the title:


**Electronic version:**


If the online version refers to a print edition, include the edition number after the title.

**Long URLs**

Use a soft return (Shift + Enter) to break long URLs before punctuation i.e., / or –

**Two entries by same author, same date:**


If a DOI is assigned, use it as in the example below.

Author, A. A. (year of publication). Title of work. Location: Publisher.
Author, A. A. (year of publication). Title of work. doi:xxxxx
Author, A. A. (Ed.). (year of publication). Title of work. Location: Publisher.

Book with single author:

Book with multiple authors:

Two to six authors:

More than six authors:
After the sixth author's name and initials, use et al. to indicate the remaining authors.

Book with editor(s):

Book, author not known:

Book with author and editor:

Book other than first edition:

Book with more than one volume:

Electronic-only book (APA, 2010, p. 203)
Book with corporate author:

When the author and publisher are identical, use the word "Author" as the name of the publisher. (APA, 2010, p. 203)


Chapter or article in a book (APA, 2010, p. 204)


Dictionary, encyclopedia
If an entry has no author listed, place the title in the author position.

Dictionary entry, encyclopedia article

Online dictionary, encyclopaedia

Notes for Journal Articles

DOI – Digital Object Identifier
A digital object identifier (doi) is a series of numbers and characters that identify online journal articles (and some paper journal articles). Include the doi in your reference for online and paper articles if it has one.
If you cannot see the doi (often top or bottom of title page) you can try to find one at http://www.crossref.org/guestquery/ (you do not have to do this for paper journal articles).
If you still cannot find the doi, find the URL of the home page of the journal on Google.
If you cannot find the home page of the journal, write the reference without a doi or URL.
Pagination by issue vs. pagination by volume

Each volume of a journal will usually contain more than one issue
i.e., Journal of Style, volume 10, Issues 1-4

Pagination by issue: page numbering starts from 1 at the beginning of each issue.

When a journal has pagination by issue, you include the issue number in the reference.

Pagination by volume: page numbering starts from 1 at the beginning of each volume and continues throughout all the issues of that volume. The page numbers of individual issues do not start at page 1 (apart from the first issue in a volume).

When a journal has pagination by volume, you do not include the issue number in the reference.

Journal Articles (APA, 2010, pp. 198-199)
(see explanation of doi and pagination in Notes for Journal Articles above)

Journal article: with doi, pagination by issue

Journal article: with doi, pagination by volume

Journal article: without doi, pagination by issue

Journal article: without doi, pagination by volume
Websites & online resources

Author, A. A. (Date of publication). Title of Page/Document. Retrieved from URL.

"Do not include retrieval dates unless the source material may change over time (e.g., Wikis). (APA, 2010, p. 192)

Web page

Web page: no author
When there is no author for a web page, the title moves to the first position of the reference entry:

Cite in text the first few words of the reference list entry (usually the title) and the year.
For title of an article, a chapter or a web page use “double quote marks”.

Website: no author, no year, no page number

In-text citation may include one of the following:

- A paragraph number: (para. 1)
- A heading plus a paragraph number within that section: (Discussion section, para. 1)
- Or, if the heading is too long, a short title in quotation marks.

Facebook

Because content from private or friends-only Facebook pages or profiles is not retrievable by everyone, if you cite it, it should be treated as personal communication (below).

Newspaper article (including discontinuous pages) (APA, 2010, p.200)

Lecture notes
Further Examples

**Conference Papers** (APA, 2010, p. 207)
Proceedings of meetings/symposia published in a book format to be formatted as a book citation.
Proceedings of meetings/symposia published in journals to be formatted as journal article citations.

**Unpublished conference paper, unpublished paper**
Author, A. A. (Year, Month). *Title of paper*. In E. E. Chairperson (Chair), *Title of symposium*. Symposium conducted at the meeting of Organization Name, Location.


**Published conference paper in conference proceedings**
Author. (Year). *Title of paper*. In Editor (first initial, last name) (Ed.) *Title of conference proceedings* (page numbers). Place of publication: Publisher. doi:xxx.xxxxxxx


**Thesis** (APA, 2010, p. 207)

**Government publication: Australian Bureau of Statistics (ABS)**

**Government publication: government department**

**Government report, corporate author** (APA, 2010, 205)
**Book Review** (APA, 2010, p. 209)


**Personal communication- letters, email, interviews, telephone conversation.**

Because they don't provide recoverable data, personal communications are not included in the reference list. Cite in text only.

M. Jones (personal communication, April 4, 2002)
(R. Brown, personal communication, July 23, 2000)

**Audiovisual**

(In text citation, include side and band or track numbers.)

**In-text citations**

**Short quote - less than 40 words** (APA, 2010, p.171)

Place quotes of less than 40 words in quotation marks within the text:

This is reflected in the idea that "schools of thought, methodologies and research techniques reflect their social origins" (Hayes, 1995, p.53)

**Long quote – more than 40 words (block quote)**

Long quotes, (more than 40 words), put it in a freestanding block of text (block quotation) without quotation marks. Indent the block about half an inch (1.27 cm)

On the Insert tab, the galleries include items that are designed to coordinate with the overall look of your document. You can use these galleries to insert tables and other document building blocks. When you create pictures, charts, or diagrams, they also coordinate with your current document look. (Gittins, 1998, p. 59)

If your block quotation contains more than one paragraph, indent the first line of each a further half inch:

On the Insert tab, the galleries include items that are designed to coordinate with the overall look of your document. You can use these galleries to insert other document building blocks. When you create pictures, charts, or diagrams, they also coordinate with your current document look.

You can easily change the formatting of selected text in the document text by choosing the Quick Styles gallery on the Home tab. Most controls offer a choice of using the look from the current theme or using a format that you specify directly. (Gittins, 1998, p. 59)
In-text citations (continued)

One author
(Griffiths, 1988)
Griffiths (1988) stated that...

Two authors
If a work has two authors, always cite both names every time.
(Griffiths & Clyne, 1988)
Griffiths and Clyne (1988) stated that...

Three, four or five authors
The first time you cite this work in a paragraph:
(Muspratt, Luke & Freebody, 1997)

The second and subsequent citations in the same paragraph:
Muspratt et al. (1997) found that...

Six or more authors
Cite only the surname of the first author, followed by et al. and the year for all citations:
Smith et al. (2001) or (Smith et al., 2001)

Long author
The first time you cite this work in a paragraph:
(Australian Bureau of Statistics [ABS], 2000)

All subsequent text citations:
(ABS, 2000)

Some group authors would be written in full every time, e.g., University of Sydney.

No author (APA, 2010, p.176)
If there is no author, use the title. If there is no title, use the first few words of the article.
Do not use ‘Anonymous’ unless the author is actually given as ‘Anonymous’.

For title of an article, a chapter or a web page use “double quote marks”:
(“Evidence Based,” 2010)

For title of a periodical, a book, a brochure, or a report use italics.
(College Bound Seniors, 2010)